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How to use the document

Dear User,

This manual is intended for project engineers, commissioning engineers or programmers
of drive and automation solutions on the CANopen and EtherCAT field bus.

It is assumed that you are already familiar with these field bus systems through appro-
priate training and from reading the relevant literature. We assume that your drive is
already in operation — if not, you should first consult the Operation Manual.

)

NOTE: This manual applies to the ServoOne position controller system,
so you will see only the abbreviation SO used below.

2

Introduction

Use of the iPlc
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Important! Misoperation may result in damage to the drive or malfunctions.

Danger from rotating parts! Drive may start up automatically.
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1 Introduction

This manual gives a short introduction how to use the iPlc programming interface.

With this manual the user can start creating own programs which assist and add the
functions of the ServoOne and ServoOne junior.

1.1 IPlc Overview

A programmable logic controller (PLC) or programmable controller is a
digital computer used for automation of electromechanical processes, such as control

of machinery on factory assembly lines, amusement rides, or lighting fixtures. PLCs are
used in many industries and machines. Unlike general-purpose computers, the PLC is
designed for multiple inputs and output arrangements, extended temperature ranges,
immunity to electrical noise, and resistance to vibration and impact. Programs to control
machine operations are typically stored in battery-backed or non-volatile memory. A PLC
is an example of a real time system since output results must be produced in response
to input conditions within a bounded time, otherwise unintended operation will result
[Wikipedia].

1.1.1 iPlc Characteristics

¢ No additional “PLC hardware” is needed — the iPlc uses free CPU power of the
ServoOne.

¢ No special firmware is needed. The iPIc is already included in the ServoOne firm-
ware (2.20-01 or higher) and in the ServoOne junior firmware (1.10-01 or higher).

¢ The PLC needs to be activated by a unique licence code. This licence code needs
to be entered into the ServoOne by using the LTi DriveManager5. A licence code is
assigned to one drive.

1.1.2  Programming Environment

The iPlc uses the CoDeSys 3.x programming environment (based on IEC 61131). This
programming environment is available in the Downloadarea at http://drives.It-i.com/, the
Homepage of LTi DRIVES.

1.1.3  iPlc Implemented Functions
e CoDeSys 3.x standard functions (e.g. timers, trigger-functions, flip-flops, counter)
* Functions for single-axis positioning (absolute, relative and endless positioning)
e motor control (Start, Stop, Quickstop, Halt)
e status and diagnosis
¢ Read and write access to all parameters
e Access to in-/outputs

11.4 Performance

The speed is limited by the free CPU power (typically cycle times down to 1 ms are possi-
ble, 5ms are recommended).

The iPlc performance depends on the activated functions (e.g. motor control type,
profile-generation, field-bus-communication) in the ServoOne.

Cyclic access to predefined parameters: analog and digital I/0 and PLC-Parameters (10 x
real, 20 x integer, 20 x double-integer).

1.2 Additional Documentation

Please notice that our additional Documentation is available in the Downloadarea at
http://drives.|t-i.com/.

¢ ServoOne operation manual
¢ ServoOne application manual

Quick Start Guide iPlc ServoOne 7
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3S-Smart Software Solutions GmbH also provides an online help for the CoDeSys pro-

gramming system.

¥ Untitled1.project - CoDeSys

File Edit Wiew Project EBuld Cnlne Tools  wWindow | Help
Nl & 3 w | gk 45| A@ Contents Ckrl+Shift+F1
n . [7] Index CultshifteFz [
7 | ¥3 Sortby - zlSDrt order = | &4 Find @ Search
- '@ Lintitied 3% Homepage. ..
-ﬂ Device (ServoOne)
= Bg PLC Logic Autarnation Aliance Homepage. ..
'0 Application Abaut,
m Library Manager I
~[E] PLC_PRa (PRG) 4
=[] Task Configuration 1

----- Qfﬁs MainTask

Figure 1.1 CoDeSys Help
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2 Use of the iPIc

2.1 Requirements for using the iPlc

* LTi ServoOne with iPIc licence

¢ ServoOne software “DriveManager5” (V5.3.9 or above)
e CoDeSys 3.x programming system

¢ ServoOne drive description 1.1.1.0 or higher

¢ ServoOne basic motion library 1.1.4.2 or higher

¢ ServoOne standard library 1.0.0.0 or higher

The DriveManager Software, the CoDeSys programming system, the device description
and the libraries are available on our homepage http://drives.It-i.com/ (Downloadarea).

The ServoOne can be ordered together with an iPlc licence. These ServoOne contains a
“1" within the model number.

ServoOne : SOBX XXX XXXX.XTXX.X
ServoOne junior : SO2X.XXX.XXXX.XTXX.X

The licence code can also be ordered separately and the iPlc functionality can be added
later on together with the serial number. The ordering number for a single PLC-licence is
1100.0000.0100.0.

2.2 Installation of CoDeSys 3.x

¢ Unzip the CoDeSys 3.x files and store these in a local directory on your computer.
¢ Double click onto the installation file.
¢ Follow the instructions during the installation process.

2.3 Entering the licence code

If the iPlc licence is ordered separately it will be required to enter the licence code manu-
ally.
* Open the DriveManager5

e Enter the four digit iPlc licence code in parameter P693 (Drive settings -> Administ-
ration -> Licence).

e Store value in the non volatile memory
* Reboot the device

software Licence xl

Serial number: I 102801626
Licence level: IiF'Ic basic(1] = iPle basic licence j
Licence key: I RG5Ok

Cancel Continug > | Einish I

Figure 2.1 Software Licence

2.4  Parameter settings in the ServoOne

There are several possibilities to use the iPlc:
e Start the motor control via iPlc
¢ Reference value command via iPlc
¢ Calculations
¢ Additional monitoring
¢ And much more

When the iPlc is not used for motor control or reference value command, no additional
settings in the DriveManager are necessary.

Otherwise the following settings must be done:

Quick Start Guide iPlc ServoOne 9
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Parameter Name Parameter No. Setting
MPRO_CTRL_SEL P159 sub 0 PLC(4) = via IEC61131 program
MPRO_REF_SEL P165 sub 0 PLCbasic(4) = via PLC basic library
CON_CfgCon P300 sub0 PCON(3) = Position control mode
CON_REF_Mode P301 sub 0 PG(0) = setpoint effects to profile

generator
MPRO_ DRVCOM_AUTO_START P144 sub 0 QN(1) = Start/restart drive automatically
in case of power or fault

Table 2.1 Parameter

Set control and reference

Control via IF'LC[4] = via IECE1131 program

Reference via IF'LEbasic[4] = via PLC basic lbrary

Lef L] Lo

Motor control start condition IDN[‘I] = Start/restart dnve automatically in caze of power or fault

Profile
Frafile made IF'G[EI] = zetpoint effects to profile generator j
Frofile type ILinFIamp[D] = Linear ramp [trapeziodal profile) j
Interpolation

Interpolation type ISpIineII[S] = Cubic spline interpolation j

Limit

Speed ovenide

I 10

Direction barrier IDFF[D] =Ma lacking j

Figure 2.2 Set control, reference and profile mode
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"4 Control "5022 006"

i:) Back I Mofor controf

Control mode

Figure 2.3 Control mode

2.5 Using the CoDeSys programming system

2.5.1 Start CoDeSys 3.x zﬁ

To start CoDeSys 3.x click on the desktop symbol ©oDeSys ¥3.3 Patch 1

2.5.2 Installation of the ServoOne device description

The device description contains information for CoDeSys which are nessascary to get
access to the device.
The device description needs to be installed only once.

* Download the device description from our Homepage http://drives.It-i.com/
(Downloadarea).

¢ Open Device Repository window (Tools -> Device Repository)
e Click on “Install...”

e Choose and install the device description from folder.

e Make sure that “Device description files” is chosen as file type.
¢ Close window



%EDevice Repository

Location:

(CiDokumente und Einstellungentiall UsersianwendungsdatentCoDesysiDevices)

Installed device descriptions:

Mame | Yendor | \ersion

+ m Miscellaneous
+ m Fieldbusses

+-[f] pLCs

+- 4P SoftMotion drives

Install... |
Wnimstall |

Details,, . |

Figure 2.4 Device Repository

Close

Device Repository

Locakion:

ISystem Repository

(C:iDokumente und Einstellungeniall UsersiAnwendungsdaten|CoDesysiDevices)

=

Installed device descriptions:

+. @ softMotion drives

Mame | Wendor | Wersion |
m CoDeSys SPWin Y3 35 - Smart Software Solukions GmbH — 3.2,2,10
m CoDeSys SPWin W3 3% - Smatt Software Solutions GmbH — 3.2.2,20
[ cobesys 5P win w3 35 - Smart Software Solutions GmbH - 3.3.0.0
ﬂi CoDedys SPWin Y3 35 - Smart Softweare Solukions GrbH - 3.3.0.1
[ cobesys 5P win w3 35 - Smart Software Solutions GmbH - 3,3.0,10
E CoDeSys 5P Win W3 35 - Smart Software Solutions GmbH — 3.3.1.20
ﬁ CoDedys SPWin Y3 35 - Smart Software Solukions GrbH — 3.4.1.0
[ PLcwinnT 35 - Smart Software Solutions GmbH - 3.1.1.0
E PLCWINNT 35 - Smart Software Solutions GmbH - 3.1.2.0
ﬁ PLCWINMT 3% - Smart Software Solukions GmbH - 3.1.2.1
[ PLowinRTE 35 - Smart Software Solutions GmbH — 3.1.1.1
E PLCWInR.TE 35 - Smart Software Solutions GmbH - 3.1.3.0
1 LTi DRI¥ES GmbH 1.1.1.0

:I Install... |

Uninstall

- Details...

Close

i

Figure 2.5  Device description
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2.5.3 Installation of the basic motion library

The ServoOne basic motion library contains drive specific functions like enable / disable-
functions and also motion control functions.
The basic motion library needs to be installed only once.

¢ Open the library repository window (Tools -> Library repository).

e Click on “Install...”

¢ Choose and install ServoOne basic motion library from folder.

¢ Close window

[;jiLibrary Repository x|
Location: Edit Locations...
{C\Dokumente und Einstellungeniall UsersiAnwendungsdateniCoDesysiManaged L
—Installed libraries: Instal.. |
Company:  |LTi DRIVES GmbH b
IR DR m J Unimstall |
pplication
=+ ServoCne basic motion lbrary £ 77 BRVES Gmbe
1.1.4.2
=+ ServoOne standard library £ 77 DRAVES Gmbe
1.0.0.0
Details), .
M
¥ Group by category —— |
Clase
4

Figure 2.6  Library Repository

The ServoOne standard library contains adjusted functions and must also be installed.
¢ Open the library repository window (Tools -> Library repository).
e Click on “Install...”
* Choose and install ServoOne standard library from folder.
¢ Close window

Quick Start Guide iPlc ServoOne

2.5.4 Creation and basic configuration of a new project

12

A project contains all the information CoDeSys needs to produce the software, which
finally will be downloaded to the ServoOne. The project contains program code, used

libraries and task configurations.

»

* Start CoDeSys 3.x  Cobesys¥a3Patch 1

e Open a new project (File-> New Project...)
¢ Click on "Standard project”

e Confirm with “"OK"

}E New Project ll
Cateqgories: Templates:
{1 {General)
- CoDeSys Automation Alliance ﬁ ﬁ
Empty library Emply project
Standard project:
4 project containing one device, one application, and an empky implementation For PLEC_PRG
[dame: IUnt\tIedl
Location: Ic:lcodesyslpmgramme j
0K I Cancel |
A

Figure 2.7 New Project

The device description for the ServoOne is already installed. As a result it is possible to
choose the ServoOne as the Device. Below you can choose your IEC language. In this

case please choose Structured Text (ST).



Standard Project x|

¥ou are about to create a new standard praoject. This wizard will create the Follawing
= objecks within this project:
- One programmable device as specified belaw
- A& program PLC_PRG i the lanquage specified below
- A cyclic task which calls PLC_PRG every 200 miliseconds
- & reference to the newest version of the Standard library currently installed,

Device:

PLC_PRGIm:  |Structured Text (5T) j

Figure 2.8  Standard Project

After confirming with “OK” you can see the User Interface Components:

¥ Untitled1.project - CoDeSys i =] |
File Edit Wiew Project Build Online Tools  Window Help Menu Bar
HEES #h i 4% % % 1215 | |# I Tool Bar
PLC_PRG [Device: PLC Logic: Application] 4k %
3| ¥ sortby = %) Sort order ~ 1| PROGREM PLC_PRG =
#3¥Find z VAR
=5 tnttids B[ EMD_VAR
= ﬂ Device {Servadne)
=30 pLC Logic —
=4} application hd
m Library Manager J ILI—
FLC_PRG (PRG) 1 a

= @ Task Configuration

& Mmai i i
_ _ & MainTask Editor window
Devices window

_'T | ¥ sart by = %lSDrt order ~

E.
¢S - - | |
#A°Find Wisual Element Repository = || € 0 error(s) | % 0 warning(s) | €% 0 message(s)

=g Lhiteds De... | Project [ object [ Position [
G‘ Project Settings

(Messages window )

POUs window

Precompile: €% OK

| Current user: {nobody) NS | Lnl Coll Chi v

Figure 2.9  User Interface Components

e Menu Bar: Provides menus which contain all currently available commands

* Tool Bar: Contains tool buttons for all currently available tools

* ToolBox window: Provides editor-specific tools (open from View menu)

¢ POUs window (view): For organizing the programming units (POUs, DUTs etc
¢ Devices window (view): For organizing the device resource objects

. Egitor window (view): Used for creating the particular object in the respective
editor.

e Messages Window: Precompile, Compile, Build, Download messages etc. are dis-

played in this window (message view).
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In the Devices window you find the three main parts of a CoDeSys application:
¢ POU (PLC_PRG)
e Library Manager
¢ Task Configuration

Devices £
| ¥4 Sartby - %*Surt order -
4 Find
= [ Chéibieds
= ﬂ Device {Servolne)
=l PLC Logic
= o Application
ﬁ] Library Manager
PLC_PRG [PRG)
= @ Task Configuration
& MainTask

Figure 2.10 Project tree

POUs (Program Organisation Units) contain mostly the program code of the
project.

The Task configuration contains the task of a project. A task calls one or more POUs
within the project frequently. The Library manager contains all libraries which are
needed in the project.

Now you must add the ServoOne basic motion library to the library manager.

The ServoOne standard library will be automaticly included.

Quick Start Guide iPlc ServoOne 14

e Choose “Add Library...” out of the “Libraries” menu
* Select ,ServoOne basic motion library”
¢ (Click on "OK"

x

Library | Flaceholder |

COmparty: ILTi DRIYES GrbH j

%E% Application
=2 LTi DRIYES GmbH
%E% ServoOne
< Servo0ne basic maotion library £ 7 O9ES Gmae
[aa 1.1.4.2
+
<@ Servo0ne standard library £ 5 ORES EmbH

4| |

¥ Group by cateqory v Display all versions (For experts anly)

i 1 i

Figure 2.11 Adding a library to the Library Manager

After that, you can start to write your iPlc program in the editor window by opening the
POU (PLC_PRQ).



PLC_PRG [Device: PLC Logic: Application] | 4 b x
1 PROGRAM PLC_FRG -
z VAR
3 END VAR
=
4 [
1 I
=
4 I

Figure 2.12 Editor window

In the following step the Gateway has to be configurated. Select the Gateway and click
on “Scan network”. After that select your ServoOne and click on “Set active path”.

This command sets the currently selected communication channel as the active one,
which means that all actions concerning communication will exactly refer to this channel.

/[ Device

4 X

Cammunication Setfings IAppIications I Files I Log I PLE settings | Users and Groups I Access Rights I 1/0 Mapping I 1 | 4

Select the network path to the controller:

|Gateway-1:0072.5009

j Set active path I

= .,3.1. Gateway-1
'jo 5022.006 [0072.9009] (active)

[~ Prompt network path at login
" Don't save netwaork path in project

[~ Secure online mode

Node name:
2022, 006

Target-Type:
1641000

Address:
0072,9009

Device-Mame:
Servoone

Target-ID:
16410090001

¥endor:
LTi DRIVES GmbH

Target-Yersion:

1.0.0.1

Add gateway. .. |
add device... |

Edit. .. |
Delete |
Resolve address |
Connech gabeway: |

Stcan nebwotk |

Figure 2.13 Configuration of the gateway

File Edit Miew Project Buld Online  Tools  window  Help

B EH S

Figure 2.14 Toolbar Login

=
Then click on Login to "‘E or Alt+F5.

| 25 |62 |

After that the “Device User Logon” window appears. The User Name and the Password

is “root”.
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Deyice User Logon

e

Figure 2.15 Device User Logon window

Now you can start the application by clicking the blue start arrow or F5.

Figure 2.16 Toolbar Start

The iPlc program is now running.
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